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How do I link my X account?
We believe that creating your brand and promoting yourself is everything! MV makes it easy for your fans to visit
your social media profiles directly from our platform, by allowing you to link your social profiles from a variety of
sites. 

There are two ways to link your social media, the steps for each are provided below:

1. Go to the drop-down menu 
2. Dashboard
3. Marketing Tools 
4. Social Media 
5. Add the direct links to your X profile
6. Click "Save"

You can also use this method:

1. Go to the drop-down menu
2. Settings 
3. Click "View" next to Social Media 
4. Add your X link, then hit "Save"

You will also notice that you have the option to link your X account and have your sales and uploads auto-post
directly to your X feed. For detailed steps on setting up your auto-posts, check out our article How do I link my X
to auto-post my sales?

How do I link my X to auto-post my sales?
Linking your X account to your ManyVids account is a great way to promote your content on X with minimal
effort on your part. Your sales will be auto-posted based on the frequency you choose. Here's how to set that
up!

1. Go to your drop-down menu 
2. Dashboard
3. Marketing Tools 
4.  X promo blaster
5. Click "Link your account" and follow the prompts to allow MV to access your account 

To further customize your auto-posts:

1. Go to your drop-down menu 



2. Marketing Tools 
3. MV Promo Blaster 

There you will see the different frequency options for how often you want your sales to be auto-posted!

How do I use the site Promo Blasters?

X Promo Blaster
The X Promo Blaster is an automated feature that you can turn on and link to your X account so that’ll Post
when you make a sale and link to the vid being sold.  This is a great way to promote your content automatically! 

ManyVids has great traffic internally but this is a powerful and fantastic way to engage your fans outside of the
platform as they get to see what vids are popular, discover new content, and get curious about the vids you’re
selling on your MV Profile!  

When you link your X to your MV account, the X Promo Blaster will automatically be set up to your account.

You can adjust the frequency of the auto-posts by:

1. Clicking the drop-down Menu 
2. Dashboard
3. Marketing Tools
4. X Promo Blaster (https://www.manyvids.com/MV-promo-blaster/)

ManyVids always seeks to provide creators with options. You can choose the frequency for the auto-posts
being sent out and you can turn it off, or on and off, as you see fit!  Choose between auto-posts every 2 sales, 5
sales, 10 sales, 20 sales, 50 sales or never if you wish to turn it off.  

We'd like to point out that, X does have some parameters in place against spam, so we’re limited to a certain
number of auto-posts sent out per hour. If you sold a vid and don’t see an auto-post, it could be that we’ve
reached the limit. We have no control over this X limit. 

You can also choose between posting a teaser vid, or a screenshot, under the "Post Type" selection:

Be sure to 'Save' your changes! 

So, this is a feature for X...should I still be active on X or
let the Promo Blaster take care of promo for me? 
We recommend being active on all social media channels and outlets to maximize the number of eyes on your
content! Interact with your fans, promote your content, talk up your free vids, post pics, chat with your peers, put
yourself out there and have fun doing it. You’ll make new fans, new friends, and new sales.  



How do I send a Broadcast?
Broadcast is a mass-messaging tool that lets you send direct messages to all your followers at once! 

Broadcasts can include text, pics or vids! You also have the option to send Pay to Open messages. This is a
great tool to use if you want to share a promo code, let your fans know about sales and any new vids or store
items that you've uploaded!

Your Broadcast in located in your inbox (click the chat icon in the top right corner):

Anything you send from here will go out to all your followers, and new followers will have access to previous
Broadcasts. Your followers will also receive notifications so they know to check. We're sure they'll be happy to
hear from you! :) 

How do I create a Promo Code for my store?
To create a promo code to share with your fans:

1. Go to the drop-down menu 
2. Dashboard
3. Marketing Tools 
4. Promo Codes (https://www.manyvids.com/Promo-codes/)

The initial page will have a full history of your promo codes allowing you to edit and re-activate previous Promo
Codes.
To create a new code, click Create New Promo Code (blue button) and fill out your promo details!

For each promo code you create you can select a title, promo code type ( markup codes increase the price of a
sale, this is generally used for financial domination fetish), discount percentage, item/services it applies to, if it
apply to items currently on sale (that are already marked down) and the date range of the promo code for when
it will be active and when it will deactivate. Don't forget to save the changes!

You can share promo codes on your Activity, Broadcast, Club on your social profiles or wherever you like!
Members will be prompted to use this at checkout and it will only work on your own store.

Please note, if a member uses a promo code to pay for a service that is recurring, they will continue to pay the
promo code/ discounted price as long as they continue to auto-renew, this is also true if you edit the price of that
service.

Why aren't my X auto-posts sending?

Intro
If you connected your X account to your MV account, but your auto-posts aren't appearing on X, the reason is
almost always the caps X imposes on automatic posts.



X caps automatic posts
X has several caps that can prevent some auto-posts from appearing:

Overall daily cap for MV is 10k posts-- this includes all posts from all accounts on MV
Overall monthly cap for MV is 300k-- this includes all posts from all accounts on MV
X caps auto-posts to 100 posts per user, reset every 15 minutes. This cap includes posts from any other

platforms you might be using.

These caps are the cause of the overwhelming majority of issues with auto-posts, and if reconnecting your X
(see below) doesn't work, then the issue is almost 100% caused by cap imposed by X. Due to the high volume of
auto-posts sent out by MV, we regularly hit these caps.

If you have other sites that are sending auto-posts on your account, you can adjust your post frequency by
going to your drop-down menu > Dashboard > Marketing Tools > X Promo Blaster as this is where you can
change the frequency of your auto-posts for sales to see if it's set to your liking.

Relinking your X

NOTE: If this troubleshooting doesn't resolve the issue, it means that the MV is hitting X's auto-post caps.
These caps are imposed by X and we aren't able to bypass them. See the previous section for details.

You can try to unlink and relink your X account to your MV Account, as this often solves any potential issues
with MV's link to X. To do so, go through the following steps:

1. On X, go to Settings & Support > Settings and privacy > Security and account access > Apps and sessions >
Connected apps > ManyVids App > "Revoke app permissions" (This must be done prior to relinking your account
or the issue will persist).
2. On ManyVids, go to your drop-down menu > Dashboard > Marketing Tools > X Promo Blaster and remove
your X URL, click 'Unlink X account' then save.
3. Add your X link again and hit Save, then click "Link X account", enter your X login credentials and hit
"Authorize app".
4.  Mark your posts as sensitive on X by going to your Settings > Privacy and Safety > Your posts > Mark as
sensitive
5. After relinking your X, be sure to go to your drop-down menu > Marketing Tools > MV Promo Blaster to set
your auto-posts to your liking.

I see other Creators' auto-posts. Why aren't they hitting X's
post caps when I am?
The short answer is that they are! Whether or not an auto-post appears is a matter of timing.

X's post caps reset after a certain time period. This means there is a window in which auto-posts are possible.
If a sale happens after the cap resets, but before we hit the cap again, then the auto-post will appear on X
without issue.

If your posts aren't appearing, but other Creators' are, the reason is that their sales occurred before the post



limit was reach.

Tips for becoming a successful Creator!
MV is an adult social media platform that gives you a storefront from which you can sell your content and
generate revenue. Like all social media sites, being active and engaging with fans is the key to becoming
successful. Here are some tips to get noticed as a successful content creator:

Create a fun profile by uploading vids, store items, and adding services (Club, Custom Vids etc). Did you know
that just uploading a profile picture will increase your chance of sales by almost 65%?

Upload a minimum of 7 vids to offer variety to your fans to choose from.
Have fun and interesting store items such as lollipops, costumes, shoes etc. Store items are usually physical

goods but can also be photo sets and texting / chatting packages.
If you have more than 7 vids, 5 store items, and a profile picture, it will increase your chances of selling of

almost 55% compare to a profile with less choices.
Using your social media profiles and inviting your fans to visit your MV Profile is the best way to get started.
Simply being active will make all the difference! Uploading new content and promoting it on your social media

and on MV will increase your chance of sales by over 80%.
We have the X Promo Blaster, which will automatically Post out your sales from your X profile. So, make sure

to link your X account!
We also have the Promo Blaster where you can post your sales on the MV Feed! You can toggle how often

you want these to post by going to your drop-down menu > Dashboard> Marketing Tools > Club Promo Blaster
Your fans are your best customers. Invite them to follow you on MV and stay in touch with them.

It's as easy as that! If you follow these steps and invest time (daily or weekly) you'll become a true rising Creator
in no time!

Live Show announcements!
Live is the place to be, it's interactive, easy to use and offers 80% payout.

Put one of your Live shows in the spotlight and let the MV Community know you are online through an Live
Takeover. If you would like to be added to our list of candidates for a Live Takeover, simply send an e-mail to
promo@manyvids.com and our team will be in touch with an available date.

All about MV Contests!
Why should Creators take part in contests? Contests are an exciting way for Creators to promote themselves
and their content, be seen by new MV Members, and achieve more success on MV!



When do contests happen? Every week we have a new unique contest running. Sometimes the contest is a 1-
day contest (Winning Wednesday) and at other times there may be a longer theme contest happening with even
bigger prizes. 

What type of photo can I submit? We encourage everyone to get creative with their themed photos! Our only
request is that your entry includes SFW content. If you want to learn more about acceptable SFW content, please
check out the requirements in the link here, under 'Photo'. Entries should also follow our external links policy
which you can find more about here. Participating in contests is easy! No matter if you win or not, you'll be sure
to have a great time and get additional exposure for your MV profile.

Check out this article to get tips on how to win an MV Contest! 

Promote Your Content: MV Ads
At ManyVids, we want all content creators to thrive and be as successful as possible. To help Creators gain
exposure and drive traffic to their MV Profiles, we have set up a new promotional tool called MV Ads. This
feature has been in the works for quite some time, and we are pleased to offer MV Ads for free until further
notice. 

This opportunity will be available to all Creator types. The MV Ad will appear on the main Vids page in the first
card on the “Being Viewed” section and on the Vid Player page, in the top right-column of the vid scroller. Each
Creator selected will have a vid of their choice appear there for an entire 24 hours!  

If you would like to submit your content for a chance to get your vid featured, follow the steps below on X:  

Choose a vid from your MV Profile that follows all our Content Rules  
Post the link to the vid you would like to have appear as an MV Ad
Include the hashtag #MVPromo in your post  
Tag @ManyVids in your post  

The MV Team will select vids for this promo based on diversity, creativity, and unicity. If your vid is chosen to be
featured and follows all our Content Rules, someone from the MV Team will reach out to let you know! 

MV Members — supporting your favorite Creators has never been easier. RT to share and comment on their
entries on social media to show them some love & help their content get noticed!

Creators - Premium Content Library
We are excited to feature Creators and their content on the Premium Membership Content Library!

With Vids linking back to Creator profiles, our Premium Members will become supporters and fall in love with
the content you offer. For the time being, we are kickstarting this project with content from select Creators but



will continue exploring new ways to extend this offer to more Creators so everyone in the MV Community can
benefit from this initiative! 

Check out our FAQ below, and as always, if you have any additional questions, reach out to our MV Support
team - help@manyvids.com

How is this a benefit to the community?
Given our Premium Members are such loyal users, we wanted to give something back. We hope to give our
Premium Members even more reasons to keep coming back and seeing our amazing creators. In 2023 we
expect to bolster our offer even more with additional perks for our Premium Members which they can use to
support their favorite creators.

How do I get my content added to the Premium Library?
If you have any interest in submitting a piece of content to be part of the Premium library, we encourage you to
reach out to promo@manyvids.com, and someone from our team will get back to you as soon as possible!

Will ManyVids be adding Gay and Trans content to the
Premium Library?
We love and appreciate our LGBTQIA2+ community, we acknowledge the omission in our first release of this
feature, and we’re working hard on the tech side to make it possible to offer a fully diverse and inclusive library
while giving Premium Members the necessary tools to sort and filter per their content preferences. This is a top
priority, and we’ll keep the Community updated as this new feature evolves and we expand our library in the near
future, so that more Creators can benefit from this initiative!

Club Leaders Contest

What is the "Club Leaders Contest"? 
The Club Leaders Contest is a Contest based on both FREE voting and Club activity. Creators enter the contest
by participating from the Contest page (uploading their entry photo). Once voting starts, Creators will earn
points for any FREE votes received, and they will also earn points for the activity happening within their Clubs on
ManyVids. Winners will receive cash prizes in addition to some amazing promotional opportunities! 

Points will only start being counted once the contest voting begins. If items are removed or actions are undone,
the points will be reversed. 

So, how can you collect points and climb up the ranks to win BIG? By uploading, promoting, and getting fans to
engage with and subscribe to your Club! 

How Do the Points Work?  
Free Votes - 1 point each 
First-time Club Activation - 10,000 points 
Club Feed "Like" (on paid posts only) - 10 points 



Club Feed "Comment" (on paid posts only) - 50 points 
Club Feed "Share" (on paid posts only) - 100 points 
Trial Subscription - 100 points 
1-month Subscription - 1000 points 
3-month Subscription - 5000 points 
6-month Subscription - 10,000 points 
12-month Subscription - 20,000 points 
New Club Vid Upload - 500 points 
New Club Pic Upload - 250 points per photo 
New Club Text Post - 100 points 

Any behavior or actions intended to skew the points system or falsify activity for points will result in
disqualification. 

What Are the Prizes? 
1st place: $750 cash prize + your content featured on the "Sponsored" rotation on ManyVids.com for 1 week

2nd place: $500 cash prize + your content featured on the "Sponsored" rotation on ManyVids.com for 5 days

3rd place: $250 cash prize + your content featured on the "Sponsored" rotation on ManyVids.com for 2 days

4th place: $100 cash prize + your content featured on the "Sponsored" rotation on ManyVids.com for 1 day

How to Get the Most Out of the Promotion as a Creator: 
Promote: Let your audience know about the promotion. This can be done through social media. Inform your
followers about the opportunity to support you. 

Engage with Your Audience: During the promotional period, engage and interact with your audience. Encourage
them to help you collect points by performing specific actions with your Club and incentivizing them to interact
with everything! 

And remember! Any activity within your Club will not only collect you points in the Club Leaders Contest, but it
will also help you climb the ranks on our Top Club Earners page – making you eligible for even more cash
bonuses at the end of every month! 

Just The Tip

What is "Just The Tip"? 
"Just The Tip" is a limited-time promotion offered by ManyVids, which empowers Creators by allowing them to
earn a higher payout on the Tips they receive. During the promotional period, Creators will receive a 90% payout
on all Tips received. 

Important Information:



This promo does not apply to Custom Vid Tips.
This promo is only offered to purchases made with credit card and/or MV Wallet (Crypto & TrustPay will not

be an option on checkout).

How to Get the Most Out of the Promotion as a Creator: 
Promote: Let your audience know about the "Just The Tip" promotion. This can be done through social media,
Broadcast, or your direct messages. Inform your followers about the opportunity to support you and take
advantage of the increased payout. 

Engage with Your Audience: During the promotional period, get creative with your content offerings, engage
with your audience, interact with them, and produce high-quality content to encourage more Tips and reap the
benefits of the 90% Payout! 

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Director’s Cut Event
The "Director's Cut" Event is a limited time offer available on ManyVids. Members will receive a 10% discount
(on us!) when ordering a Custom Vid from any Creator on the platform. Custom Vids are personalized, providing
a unique and tailored experience for Members who are looking for something special and want to take a seat in
the Director’s chair. 

How does the "Director's Cut Event" work? 
Members can place a Custom Vid order from the Creator of their choice during the promo period
10% OFF will be applied at check out and the Creator earnings will not be impacted by this discount
10% OFF will be applied on the total price of the Custom Vid order (including any Extras) but will not

include any Tips sent with the order
This offer cannot be combined with any other promo codes or discounts
The 10% OFF is only offered to purchases made with Credit card and/or MV Wallet (Crypto & TrustPay will

not be an option on checkout)

How to Get the Most Out of the Promotion as a Creator: 
Promote: Let your audience know about the promotion. This can be done through social media, Broadcast,
or via direct messaging. Inform your followers about the opportunity to support you and take advantage of
the discount, on us. 

Engage with Your Audience: During the promotional period, engage with your audience, interact with them, and
produce high-quality content to encourage more Custom Vid purchases. 

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Shop Til' You Drop



What is the Shop Til' You Drop Promotion?
The Shop Til' You Drop promotion has been revamped and is now better than ever, offering fantastic
opportunities for all Creators. During the promotional period, when you sell 3 or more Store Items (excluding
Vids), you'll unlock a 90% payout on Store Items sold during the promotional period!

Important Information:
The promotion applies to Store Item sales only. Any additional Tips sent during the checkout process do not

count toward the promotional payout.

Vids, Custom Vids, and Vid Bundles  sold as Store Items are not eligible for the 90% payout and do not count
toward the 3-Item minimum required to qualify for this promotion.

Prices must remain unchanged  throughout the promotional period. Adjusting prices may result in disqualification
from the promo.

Payouts will be manually calculated after the event. Qualifying Creators will receive their additional earnings within 48
hours of the promotion's end.

How to Get the Most Out of the Promotion as a Creator:
Promote Your Store: Let your fans know about the Shop Til' You Drop promo! Share the excitement via social
media, Broadcasts, or direct messages. Highlight new and exclusive items to drive engagement.

Engage with Your Audience: Connect with your audience during the promotion to encourage more sales.
Whether it's offering unique and one-of-a-kind items or high-quality digital content, interaction is key to boosting
your success.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Broadcast Blast

What is "Broadcast Blast"?
The “Broadcast Blast” is a limited-time promotion on ManyVids where Creators are encouraged to use the
Broadcast feature (formerly MV Flyer) to share their content links and have the chance to win promotion!

During the promotional period, we invite Creators to send links to their Vid Bundle through a Broadcast
message. The top 3 Creators who earn the most revenue from that specific service via Broadcast during the
promo period will each receive a social promo and and be included in the Ad Spot rotation for 7 days.

 How do I send a Broadcast?
For details on sending a Broadcast, visit our Help Center article here.

Tips to Get the Most Out of the Promotion:
Promote: Spread the word about the promotion! Use your socials to let your followers know about this

opportunity so they can support you and help you win 1 of 3 promo opportunities!
Engage with Your Audience: Actively interact with your audience during the promotional period to boost your



Broadcast’s reach and impact.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

10% Off Discounted Vids
The "10% Off Discounted Vids" is a limited-time offer on ManyVids. During the promotional period, Members will
enjoy an extra 10% discount on individual Vid purchases—courtesy of ManyVids! Discounted Vids from
participating Creators will be highlighted on pages that display Vids, giving more visibility and potential sales to
those who join the promotion.

How Does it Work?

When a Member purchases a discounted Vid during the promotional period, they will get an additional 10% off,
on us! This offer applies to all individual Vid purchases and does not apply to Vid Bundles.

How Do I Participate as a Creator?

To participate as a Creator, simply discount the Vids you wish to include in the promotion! We will be prioritizing
showcasing discounted Vids on all pages for maximum exposure.

Tips to Maximize Your Success as a Creator:

Spread the Word: Expand your promotional reach by letting your followers know about this great deal! Spread
the word through your social media, by sending a Broadcast, or even direct message your most loyal Members
to inform them about the 10% discount.

Engage and Connect: Now is the perfect time to boost your engagement. Interact with your audience, share
updates, and create irresistible new content to encourage more Vid purchases. The more you connect, the more
likely Members will take advantage of the promo.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

ManyVids LIVE Gaming
At ManyVids we love all things gaming and live streaming, so we are excited to announce our LIVE Gaming
Event is back!

ManyVids LIVE Gaming is a chance for Creators to show off their gaming skills, creativity, and to have fun with
the community! For 24 hours, celebrate your passion for gaming with fellow Creators and Members!

The options for the event are endless! Stream your favorite game, dress up in cosplay as a cool character, chat
about your latest gaming adventures and high scores, or anything else game-related for a chance to win 1 of 4
cash prizes! Winners will be chosen based on creativity, innovative setups, captivating themes, and engaging
streams.

How to participate:

Announce your live stream on social media using #ManyVidsGaming



Go LIVE anytime during the event

Prizes:

1st place: $500
2nd place: $250
3rd place: $150
4th place: $100

Members, join the fun by tuning into live streams and tipping your favorite gamers with Tokens!

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Love At First Sale Event
Unlock Your Earning Potential with ManyVids' "Love At First Sale" Event! 

Are you a budding Creator on ManyVids looking to kickstart your journey into the world of adult content
creation? Or perhaps you've been on ManyVids for a while but haven't quite taken the plunge into uploading
content and making your first sale? Well, we've got exciting news for you! ManyVids is thrilled to introduce the
"Love At First Sale" Event, a special promotion designed to reward new Creators and inspire a wave of creativity
on our platform. 

We understand that starting out can be challenging, and we want to encourage Creators to upload engaging
content and make their first sale on ManyVids! 

Here's where it gets exciting – any NEW Creators* who make their first sale during the month of February will be
entitled to a fantastic 10% BONUS on their payout at the end of the month. This bonus applies to the total
amount earned by the Creator throughout February and will be manually added to their accounts during the first
week of March, just in time for the regular March 16th payout. 

We want to make this as inclusive as possible, so the additional 10% applies to any amount earned across any
ManyVids product, including: 

Vids 
Custom Vids 
Vid Bundles 
Clubs 
Live 
Store Items 
Tips 
Contest Votes

To create a buzz around this exciting event, we're encouraging Creators to use the hashtag #FirstMVSale and
tag @ManyVids on their promotional posts for a chance to be reposted and shared. We'll be showcasing the
very best content throughout the month, giving Creators an additional opportunity to earn more and gain
visibility. 

The "Love At First Sale" Event is not just a promotion; it's a golden opportunity for ManyVids Creators to unleash
their creativity, make that first sale, and boost their earnings. Let February be the month you take your ManyVids



journey to new heights!  

So, if you're a new ManyVids Creator or have been contemplating joining or using the platform, now is the
perfect time to dive in – the sky is the limit! 

*This promotion is available for newly joined Creators or existing Creator accounts who have not made their first
sale. This does not apply to secondary accounts of existing Creators who have already earned their first sale on
ManyVids. One account per legal name can qualify.

Pilot Season: Your Big Break Awaits on ManyVids!

Pilot Season: Your Big Break Awaits on ManyVids! 
This April, ManyVids is launching into uncharted territories with our first-ever Pilot Season—a groundbreaking
initiative designed to spotlight your creativity and bring fresh, original content to the forefront of the adult
content creation world. Have you been nurturing a brilliant idea for a show? It's time to take center stage and let
your creativity soar. We're not just watching; we're ready to green light your next big safe-for-work project! 

What's Pilot Season All About?  
Pilot Season runs from April 1st to April 30th, and it's all about discovering and elevating new SFW shows that
captivate and entertain. This is your golden opportunity to pitch your show directly to the ManyVids community
and see it come to life with full production support. Here's how to make your mark: 

Upload Your Pilot: Creators are invited to upload new pilot episodes of their SFW shows to ManyVids using
the category tag "SFWpilot" during the promo period. Whether it's a concept that's been brewing in your mind or
a show you've already launched elsewhere, as long as it's new to ManyVids and SFW, it's eligible. 

Safe-for-Work Focus: Your profile must feature a minimum of 5 safe-for-work videos to qualify. We're looking
for content that broadens the scope of creativity and appeal on our platform. 

Promote Your Show: Take to Twitter or Instagram to share a short clip or teaser of your show. Use the
hashtag #SFWpilot and tag @ManyVids to ensure your submission gets noticed. The promotion isn't just about
participation; it's about building buzz and excitement around your creative vision. 

Win Big: ManyVids will select the most compelling pilot videos and green light a full order of new episodes,
offering financial backing to bring your vision to life. This is your chance to transition from creator to
showrunner, with ManyVids supporting your journey every step of the way. 

Calling All Members: Be Part of the Magic   
Your voice matters! As we unveil the array of pilots, your engagement can help decide which shows will get the
green light. Show some love to these productions, share your favorites, and let us know which ones you believe
deserve full ManyVids funding. Your support can make all the difference in bringing innovative and
entertaining new content to our community.   

Ready to Launch? 



April could be the month you take the leap from creator to cinematic pioneer. Dive into Pilot Season with your
unique show concept, and let's create something spectacular together. With the support of ManyVids and the
enthusiasm of our incredible community, there's no limit to where your creativity can take you. 

Pilot Season is not just a promotion; it's a launching pad for your creativity and a testament to the power of
community-driven content. Let's make April a month to remember. Upload your pilot, share your vision,
and let's revolutionize the landscape of content on ManyVids together! 

Winners will be announced in May after all submissions are reviewed. Get ready to showcase your talent
and possibly see your show in full production, thanks to ManyVids! 

Mention Madness Promo

What is "Mention Madness"? 
It’s time for Mention Madness on ManyVids! Mentions are HERE and we want to help spread the love - tag your
fellow Creators on your FREE Club Feed during the promo period to help spread positivity in the community,
show love to your peers and a chance to win exclusive promo!

How do I participate?   
To enter, simply create a post on your FREE Club Feed mentioning another Creator (Type @ and start typing a

name to select someone from the drop-down). 
You can promote their content, their profile, a collab you did together, or simply give them a shout out just to

spread some love - as long as you mention them, you will be entered!
Encourage your followers to interact with the post(s)
And, at the end of the promo period,  the 3 Creators whose FREE Club posts have the most

engagement/interaction (reposts, comments, likes) will win the amazing promotional opportunities listed below
to help put them and their content in the spotlight! 

What are the prizes?   
1st place: An email blast sent to our subscribed Members promoting your Profile and content
2nd place: A pop-up announcement on the ManyVids platform for 24 hours promoting your Profile and

content
3rd place: Your content will be added to all of the ad-zone rotations on the ManyVids platform for 1 week

Additional Details:
Creators must have the following to enter:

A minimum of 10 Vids uploaded on their Profile
A minimum of 6 Store Items on their Profile
An active Club on their Profile
Offer Custom Vids on their Profile



Keep in mind, anyone you mention will get a notification that you've mentioned them in a Club post, inviting
them to check it out and reply!

How to Get the Most Out of the Promotion as a Creator: 
Promote: Let your audience know about the promotion. This can be done through social media, Broadcast, or
via direct messaging. 

Engage with Your Audience: During the promotional period, engage with your audience, interact with them, and
encourage them to support you by engaging with your posts!

LIVE: Gaming & Upload Event
Dust off your headset and get ready to log on! The ManyVids LIVE Gaming & Upload Event is here, and we want
to see you show off some serious skills. 

There’s simply nothing better than seeing the MV Community come together to support and celebrate one other
– especially when gaming and cosplay are involved! 

Want to participate?  

GO LIVE for gaming themed stream on ManyVids at any time on June 14 and hit record! You can stream
yourself playing a difficult retro game, show off your newest cosplay fit, or chill out and listen to your
favorite video game soundtrack – there’s really no wrong way to take part! 

Then, upload your stream recording to your ManyVids Profile using the Vid tag #ManyVidsLiveGaming
by Sunday, June 16th for a chance to win BIG!  

With 3 awesome cash prizes totaling $3000 up for grabs, you won't want to miss this! 

 Prizes are as follows:  

$1000 - Most Live Viewers 

$1000 - Best VOD Upload  

$1000 - Team Choice 

For more information on how to RECORD your LIVE streams, click here. 

To get the most exposure possible, don’t forget to do the following: 

Let your fans know what they can expect during your live stream on social media with the hashtag
#ManyVidsGaming 

Pin your #ManyVidsGaming post to the top of your Twitter & FREE Feed on ManyVids 

Don’t miss out on this great way to connect with the MV Community and gain some extra exposure! Who’s
going to set the new high score, MV? 

Keep an eye on our socials to find out when the next ManyVids Live Gaming event will take place!  

Free Token Rewards at MV!
With our Free Token Rewards, you can offer your fans FREE tokens with their Vid purchases just by scheduling



your Live shows with MV!

How it Works:
Schedule a minimum of 2 Live shows within a single calendar month to unlock Token Rewards
Scheduled shows must be at least 60 minutes long
If you want to unlock Free Token Rewards for multiple months, you can schedule your monthly shows in

advance to ensure it stays activated
Members purchasing qualifying Vids from your Store within the calendar month will receive FREE Tokens with

their purchases - 1tk for each $1 spent!
Members can see how many FREE Tokens they will receive with your Vids before purchasing
Members can view the tokens they've received in their Purchase History

Your Members will be notified via an automatic post to your Club feed when you've activated the Rewards and
will also receive notifications for scheduled shows to bring traffic to your room—but you'll also want to
Promote! Promote! Promote! to encourage your followers to spend their Tokens on you!

Creators can easily monitor the Tokens their Members have earned through the Free Token Reward Program by
visiting the “Live” tab on their Profile. Don’t forget to use the Broadcast feature to send invitations and
encourage Members to join your scheduled live shows!

Note: Tokens are calculated based on the final price after all other promotions are applied. Tokens Rewards will
not be applied to valid purchases during other token giveaways.

Live Banner Templates
Bring more attention to your scheduled live streams by creating standout banners for your live shows!
 
You can create your own banner, or if you need some help creating a banner, you can easily make one using one
of our Canva templates! All you need to do is add your stream details to the template.
 
Here's how:

Click here to access all templates
Click File > Make a Copy
Choose a template that suits you best 
Input your Show Title & Stage Name (choosing something that will grab the attention of Members)
Enter the Date and Time in Eastern Time (example: Live May 29 - 7PM ET)
Select a SFW (non-nude) image of yourself and remove the background (If you have Canva Pro: Click the

image > Edit Image > BG Remover. If you do not have Canva Pro, you can use this free background remover tool
(https://www.remove.bg/)

Input the SFW picture of yourself in place of the image placeholder
Download your banner
You can now upload your banner to ManyVids and schedule your Live Show (details on scheduling your show

can be found here)

When creating your banner please do your best to avoid putting any relevant information near the edges such as
the title/name/date/time.

We suggest creating your ad banners and scheduling your live shows in advance to ensure your members know



exactly when you’ll be live and can come prepared with Tokens!

Our team selects the best banners to be featured on the rotating carousel space on the Live homepage so don't
miss your chance to get a visibility boost!
 
Lastly, did you know that scheduling 2 Live shows per month will unlock "FREE Token Rewards" for the calendar
month and your Members will receive FREE Tokens for buying your Vids within that month?!
 
Please note that your banner must follow our Content Rules & Guidelines.
 

ManyVids Live Fest

What is the ManyVids Live Fest?
The ManyVids Live Fest is a three-day event where Creators can go live for the chance to win daily cash prizes
and promotion! Members can also join the live fun; by helping their favorite Creator earn Tokens, they will have
the opportunity to win awesome prizes.

How to participate:
Creators need to:

Schedule at least one live show during the promotional period
Go live at your scheduled show time and earn Tokens

What are the prizes?
Creators: The Creator who earns the most Tokens each day will win $500 and promotion on the Live page
carousel. We will announce the daily Top Token earner on our social feeds along with special shoutouts.

Members: The daily Top Tipper will receive a one-month free Premium Membership and 200 FREE Tokens.

How to Get the Most Out of the Promotion as a Creator: 
Promote: Let your audience know about the live event. This can be done through social media, Broadcast, or via
direct messaging. Let your followers know when you are going live and to join your scheduled shows during the
event. 

Engage with Your Audience: Before and during the live fest, engage with your audience, interact with them, and
encourage them to purchase Tokens in advance so they can be ready to tip you. 

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*



FREE Premium with Club Subscriptions
What is the FREE Premium with Club Subscriptions Promotion?

The FREE Premium with Club Subscriptions is an exciting promo on ManyVids! During the promotional period,
when a Member subscribes to at least 1 new Club, they will receive a FREE Premium Membership for 30 days!

Important Information:

To qualify, the Member must purchase at least 1 NEW Club subscription
This promotion does not apply to Club rebills
This promotion does not apply to existing Premium Members
This promo is only offered to purchases made with credit card and/or MV Wallet (Crypto & TrustPay will not

be an option on checkout)
The FREE Premium Membership and included perks will be active for 30 days after the promotion ends

(excluding free Tokens). Check out the Premium Membership benefits here.
Club subscriptions for each month range must be between $1.99 and $29.99. For more information on how to

set your Club price and get started, click here.

How to Get the Most Out of the Promotion as a Creator:

Promote Your Club: Spread the word! Let your fans know about the promo by sharing the excitement via your
socials, Broadcasts, or direct messages. Highlight the exclusive content available in your Club and entice them
with your latest uploads!

Engage with Your Audience: Stay connected with your Members during the promotion. Encourage them to join
your Club by offering special content or additional uploads. Interaction and communication are key to
maximizing your subscriber count.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

LIVE SpookySzn on ManyVids
What is LIVE #SpookySzn on ManyVids?

LIVE #SpookySzn on ManyVids is a thrilling, Halloween-themed event where Creators have the chance to GO
LIVE and win 1 of 4 cash prizes by streaming their spookiest, most creative live shows. For 24 hours, join the
ManyVids community in celebrating the season with costumes, haunted cam rooms, movie marathons,
delicious treat reviews, and more! Winners will be selected based on creativity, originality, captivating themes,
and overall engagement.

How to participate:

Announce your live stream on social media using #ManyVidsLive and #SpookySzn
Go LIVE anytime during the promotional period

Prizes:

1st place: $500
2nd place: $250
3rd place: $150
4th place: $100



Whether you're joining for the chills, thrills, or just to enjoy some Halloween magic, #SpookySzn on ManyVids
LIVE is the place to be! Members, don’t forget to treat your favorite Creators by tipping them with Tokens!

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Custom Vids Giveaway
What is the Custom Vids Giveaway?

The Custom Vids Giveaway is an awesome promotion on ManyVids! During the promotional period, Members
who purchase a Custom Vid will be eligible to win their next Custom Vid of equal value for FREE—on us!

How Does it Work?

When a Member purchases a Custom Vid during the promotional period, they’ll automatically be entered for a
chance to win their next Custom Vid for FREE. Five lucky winners will be chosen at random, and they’ll receive
Wallet Credits equal to the value of their Custom Vid that they can use on their next purchase.

How Do I Participate as a Creator?

As a Creator, participating is simple! Just ensure the Custom Vids feature is available on your ManyVids Profile
so Members can purchase from you.

Tips to Maximize Your Success as a Creator:

Spread the Word: Let your fans know about this great deal! Promote it across social media, send out a
Broadcast, or message your loyal Members directly to inform them about the giveaway.

Engage and Connect: Now is the perfect time to boost engagement. Share updates and remind your audience
that you offer Custom Vids. The more you interact, the more likely your Members will take advantage of the
promo.

Get ready to score some extra cash and treat your Members to an unforgettable experience with this amazing
promo!

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

ManyVids LIVE Tournament
The ManyVids LIVE Tournament is a live event where sixteen talented Creators go head-to-head in epic battles,
all aiming to claim the title of Tournament Champion! 

How the Tournament Works:
4 Round of Battles: The tournament will follow a single-elimination format over 4 rounds.
Battle Groups: We’ll start with 4 groups of 4 Creators each, competing within bracket-style matchups.
Elimination Rules: In each match, the Creator who receives the most Tokens during their stream will advance to the

next round.
Battle Duration: All battles will start at 7 PM EST and run for a minimum of 2 hours and a maximum of 4 hours.
Grand Prize: The Creator who wins the final battle will take home an incredible $1,000 cash prize!



Tournament Dates: No tournament is currently running.

*This article will be updated daily during the LIVE Tournament with new matchups and results as the tournament
progresses!*

Monthly ​Cash Prizes
Creating content takes dedication, creativity, and hard work, and at ManyVids, we want to recognize that.
Whether you go LIVE, offer a Club, or offer a plethora of Vids, we have monthly bonus cash prizes up for grabs,
all designed to reward your efforts and give back even more to our talented community!

Monthly Cash Prize Categories:
LIVE Top Earners: $10,000 up for grabs every month for the top 10 LIVE streamers! More details here.
Club Top Earners: 10,000 in total cash prizes for the top 10 Club Creators! More details here.
SFW Most Popular Vids: Each of our 7 SFW communities have Top 4 Most Popular Vids of the month,

totaling $14,000 up for grabs! More details here.
NSFW Most Popular Vids: For our Adult community, the Top 4 Most Popular Vids of the month get a share of

$2,000 in bonus cash prizes

Tips to Maximize Your Earnings as a Creator:
Promote Your Content: Whether you go LIVE, Share Vids, or encourage Members to join your Club, a little

promotion can go a long way. Share your content across socials, engage with your audience, and let them know
about your exclusive offers and live shows.

Engage Your Members: Engaging with your followers is key. Encourage interaction in your live sessions,
release content that speaks to your fans, and keep them excited about what’s coming next.

Consistency Counts: The more you put yourself out there, the more likely your content will gain traction.
Consistent uploads and going live regularly can help you grow a loyal fan base and boost your chances of
qualifying for these bonuses.

Hard work pays off, and with these bonus opportunities, you can boost your earnings even more!

Kickstart Your Earnings!
Are you a new Creator on ManyVids who joined in the last month and haven’t made a sale yet? We’re here to
help you kickstart your journey with an exciting promotional opportunity!

From July 21st to August 20th, new Creators who make $50 or more in eligible sales will receive a 7-day
promotional feature on our Sponsored Ad Spot.

 Eligible Sales Features:
This promotion applies to sales made through the following features:



Vids
Custom Vids
Vid Bundles
Clubs
Live
Store Items
Tips
Contest Votes

Important Details:
Promotion Period: July 21st to August 20th, inclusively.
Eligibility:
You must have joined ManyVids between June 1st and June 30th.
You must not have made any sales before the promotion begins.
You must generate at least $50 in sales from eligible features during the promo period.
This offer does not apply to secondary accounts of existing Creators who have previously made a sale on

ManyVids.
Eligible Creators will receive an email notification.
Promotional Feature:
Creators who meet the requirements will be featured on the Sponsored Ad Spot for 7 days. The Ad will appear

on the adult Vids page in the first card on the “Being Viewed” section and on the Vid Player page, in the top right-
column of the Vid scroller.

The featured content will be selected by the ManyVids Team and must comply with our Content Rules.

Tips to Make Your First Sale:
Not sure where to start? Here are some tips to help you make the most of this promotion:

1. Promote Your Content: Share your ManyVids Profile on your social platforms to let Members know what
you’re offering.
2. Engage with Fans: Interact with your audience on socials or in the ManyVids community.
3. Expand Your Reach: By offering multiple features like Custom Vids, Clubs, Vid Bundles, and more, you can
reach a wider audience and increase your chances of making sales.
4. Go Live: Boost your visibility and drive sales by hosting live shows! During your stream, you can promote your
contest entries and Members can vote directly from your live room, showcase Store Items, discuss upcoming
Vids, and engage with your audience in real-time—all while earning Tokens! Going live offers a unique
opportunity to connect with Members, build excitement, and encourage immediate purchases.

10% Cash Back in Wallet Credits
The Summer Splash Promotion is a limited-time offer on ManyVids. During the promotional period, Members
will receive an instant 10% cash back in Wallet Credits on all Vid and Vid Bundle purchases. These Wallet
Credits will be automatically added to the Member's MV Wallet and can be used at a later time.



How Does it Work?
Instant Application: Your 10% cash back is instantly applied to your MV Wallet.
Exclusions: The cash back applies to the purchase price before any applicable taxes and cannot be combined

with any other promotional codes.
Tracking Your Savings:  Easily view your cash back transactions by sorting your purchase history by “ALL” or

checking your invoice for detailed information.

Eligibility and Conditions:
Promotional Window: All purchases on Vids and Vid Bundles made during the promo period qualify. Should

there be any delay in processing your payment, rest assured, we will honor the cash back based on your
checkout time.

New Accounts Welcome: New Members will receive Wallet Credits from their purchases. These credits are available
for immediate use. However, adding more funds to your Wallet will be enabled after your account is active for 30 days,
which is when a “LOAD” button will appear in your MV Wallet.

Payment Methods: This promo is offered to purchases made with all payment types.

Maximize Your Experience:
Spend and Save: Use your cash back on future purchases, enjoying even more of your favorite content at a

fraction of the cost.

Stay Informed: Keep an eye on your purchase history and invoices to track your savings and your Wallet Credit
balance.

Happy saving and thank you for being a valued Member of our community!

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Double Deal Days
Double Deal Days is an exciting new promotion on ManyVids. During the promotional period, by sending out
Broadcast messages, Creators can unlock an extra 10% discount on Store Items, funded by ManyVids!

How it Works:
Unlocking the Promotion: Creators must send out two distinct Broadcast messages, each promoting a

different Store Item.
Activation: After sending both Broadcast messages, the promotion activates, granting Members an extra 10%

off Store Items from that Creator.
Discount Period: The 10% discount applies only to sales made after activation and remains in effect until the

promotion ends.
Payment Methods: This promo is offered to purchases made with all payment types.

Tips to Maximize Your Success as a Creator:
Spread the Word: Expand your promotional reach by letting your followers know about this great deal! For the
promotion you must send Broadcast messages, but you can also spread the word through your socials or by
direct messaging your most loyal Members to inform them about the promotion.



Engage and Connect: Now is the perfect time to boost your engagement. Interact with your audience, share
updates, and create irresistible new Store Items to encourage more purchases. The more you connect, the more
likely Members will take advantage of the promo.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

The 2025 ManyVids Awards
Get ready to celebrate a decade of excellence—the 10th Annual ManyVids Awards are here! To our incredible
Creators: your passion, creativity, and commitment are what make this community truly shine. Thank you for
being the driving force behind everything we do. Let’s make this award season unforgettable!

Pre-Nomination Period:
The Awards are kicking off with new and improved pre-nominations! From January 3rd at 10 AM EST until
January 7th at 11:59 PM EST, Members have the chance to nominate their favorite Creators in any of the
available categories directly on the ManyVids platform. Once the pre-nomination window closes, Creators will
receive a notification detailing the categories in which they’ve been nominated. This early insight allows
Creators to get a sneak peek at the support they’ve received, giving them the chance to tailor their entries and
elevate their chances of taking home a crown!

How the 2025 ManyVids Awards Will Work:
As of January 8th at 10 AM EST, Creators can enter themselves into the Awards.
The voting period will run from January 13th at 11 AM EST to January 27th at 8 PM EST.
After the voting window closes, the Top 5 nominees in each category will proceed to the final round.
The ManyVids Team will determine the ultimate winners based on the total number of votes earned and an in-

house vote.
The winners will be announced on the ManyVids socials on January 30th.

ManyVids Award Winner Prizes:
A $1000 cash prize
A jewelled crown
A badge on their Profile for all to see
Winners will be featured on the Creator and Awards page all year long giving each winner exclusive exposure.

Important Information:
The first category you enter will be linked to the "Vote for Me" button on both your Profile and LIVE room.
This year, Creators can enter up to 4 categories, allowing each participant to showcase their unique strengths

and truly shine in their areas of expertise! However, if you’ve been automatically nominated for Vid of the Year,
you’ll only be able to enter 3 additional categories.

Some categories are exclusive to specific account types for Creators to ensure fair competition (e.g., the Gay
Creator of the Year category is reserved for Creators with a Boy/Gay account on ManyVids).

Creators cannot enter the “Vid of the Year” category. This category is not open for entry as the nominated Vids
are pre-selected based on the most popular Vids in 2024.

All entries must adhere to SFW Contest entry guidelines – click here to read them.



To qualify for any of the SFW Community Awards, you must have uploaded and tagged at least 3 videos
within the relevant community. Only Vids that meet the SFW criteria and are added to the Community Lander will
be considered for the Awards. Make sure your content is appropriately tagged to ensure eligibility.

Tips to Maximize Your Success as a Creator:
Promotion is key to success in any contest, and the 10th Annual ManyVids Awards are no exception! Share your
excitement with your fans on social media by letting them know which categories you’ve entered and rally their
support. If you haven’t enabled your auto-posts yet, now’s the perfect time! Auto-posts let the community know
which categories you’ve entered and notify your fans when you receive a vote. It’s an effortless way to boost
your visibility and rally support on social media without the need to post manually!

Now, without further delay, here are the 23 Award categories for the 2025 ManyVids Awards:

1. Creator of the Year: Awarded to the Creator who embodies the true spirit of ManyVids, this is the most
prestigious award of them all!
2. Beauty Creator of the Year: Awarded to the Creator who is passionate about all things beauty!
3. Best "Assets" of the Year: Awarded to the Creator whose... assets... captivate and leave a lasting impression!
4. Best Following of the Year: Awarded to the Creator with the most dedicated and supportive followers!
5. Club of the Year: Awarded to the Creator who continues to take their Club to new heights!
6. Custom Vid Creator of the Year: Awarded to the Creator who turns the wildest dreams into reality!
7. Entrepreneur of the Year: Awarded to the Creator who manages their business with exceptional expertise
and finesse!
8. Food & Drink Creator of the Year: Awarded to the Creator whose food and drink contest is a recipe for
success!
9. Gamer of the Year: Awarded to the Creator who is always levelling up and achieving the highest score!
10. Gay Creator of the Year: Awarded to the Creator from the Gay community who consistently impresses and
inspires!
11. Health & Fitness Creator of the Year: Awarded to the Creator who inspires and motivates with their passion
for health and fitness!
12. Influencer of the Year: Awarded to the Creator who's always ahead of the trends, and influences the
masses!
13. Innovator of the Year: Awarded to the Creator whose creativity knows no bounds!
14. Live Creator of the Year: Awarded to the Creator who consistently takes their ManyVids Live performances
to another level!
15. Music Creator of the Year: Awarded to the Creator who adds a harmonious touch to the Community!
16. Profile of the Year: Awarded to the Creator whose Profile radiates excellence and creativity!
17. Rising Star of the Year: Awarded to the Creator who set new standards this year. Truly the one to watch!
18. Roleplay Creator of the Year: Awarded to the Creator who transforms roleplaying into a truly unforgettable
and immersive experience!
19. Store of the Year: Awarded to the Creator who has a Store with a 5-star shopping experience!
20. Trans Creator of the Year: Awarded to the Creator from the Trans Community who doesn’t let anything
stand in their way!
21. Travel & Outdoor Creator of the Year: Awarded to the Creator who embodies a spirit of exploration and
adventure!
22. Vid of the Year: Awarded to the Creator whose unique Vid captured everyone's attention! (Vids are pre-
selected based on the most popular Vids in 2024).
23. BONUS CATEGORY: Team Choice Award - Awarded to a Creator who entered one of the award categories
but didn't win. A nod to their community spirit and immense talent!



We can’t wait to see your incredible entries for this year’s Award season and wish all our Creators the best of
luck!

Let’s make the 2025 ManyVids Awards the most thrilling yet—be sure to repost our announcement on the
ManyVids Feed and on X to spread the word!

Mark your calendars for the grand reveal on socials, where 23 Creators will be crowned the 2025 ManyVids
Award winners!

ManyVids LIVE Music Fest
We are excited to announce a new live event: The ManyVids LIVE Music Fest. This event is a chance for
Creators to show off their musical talents, creativity, and to have fun with the community! For the duration of the
promo, celebrate your passion for music with fellow Creators and Members!

The options for the event are endless! Host a karaoke show, play an instrument, sing your favorite songs, rate
different records and more for a chance to win 1 of 4 cash prizes! Winners will be chosen based on creativity,
innovative setups, captivating themes, and engaging streams.

How to Participate:
Announce your live stream on social media using #ManyVidsMusic
Go LIVE anytime during the event

Prizes:
1st place: $500
2nd place: $250
3rd place: $150
4th place: $100

Members, join the fun by tuning into live streams and tipping your favorite Creators with Tokens!

And Creators, make sure to record your live music streams so you can post them to your Profile as an additional
piece of content! Don't forget, SFW Music Vids that you upload also have the chance to be displayed on the
Music Lander and put you in the running to win monthly cash prizes too!

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Contest Themes for 2025
At ManyVids, we want to help make things simpler and more efficient, so you can focus on what you love most!

To help you better prepare for upcoming contests and maximize your chances of winning, we’re thrilled to
reveal our contest schedule for 2025!

2025 Contest Schedule:



February:

❤️ Valentine Vibes Contest – � ️ Feb 3, 11 AM – Feb 14, 8 PM ET
� ️ Mesmereyes Contest – � ️ Feb 19, 3 PM – 11 PM ET
� Boss Babe Contest – � ️ Feb 26, 3 PM – 11 PM ET

March:

� Spring Fling Contest – � ️ Mar 3, 11 AM – Mar 13, 8 PM ET
� Get Lucked Contest – � ️ Mar 19, 3 PM – 11 PM ET
� Pink Passion Contest – � ️ Mar 26, 3 PM – 11 PM ET

April:

⚫ Monochrome Madness Contest – � ️ Apr 2, 3 PM – 11 PM ET
� Selfie Star Contest – � ️ Apr 9, 3 PM – 11 PM ET
� Pastel Pop Contest – � ️ Apr 13, 11 AM – Apr 23, 8 PM ET
� May the 4th Contest – � ️ Apr 30, 3 PM – 11 PM ET

May:

� ManyVids & Chill Contest – � ️ May 7, 3 PM – 11 PM ET
� May Flowers Contest – � ️ May 12, 11 AM – May 22, 8 PM ET
� Mellow Yellow Contest – � ️ May 28, 3 PM – 11 PM ET

June:

� Color Splash Contest – � ️ June 4, 3 PM – 11 PM ET
� Sweet Tooth Contest – � ️ June 11, 3 PM – 11 PM ET
� Picnic Party Contest – � ️ June 16, 11 AM – June 26, 8 PM ET

July:

E Happy Place Contest – � ️ July 2, 3 PM – 11 PM ET
� Flower Power Contest – � ️ July 9, 3 PM – 11 PM ET
� ️ Summer Vibes Contest – � ️ July 14, 11 AM – July 24, 8 PM ET
� Super Silly Contest – � ️ July 30, 3 PM – 11 PM ET

August:

� Blue Bliss Contest – � ️ Aug 6, 3 PM – 11 PM ET
� Fashion Show Contest – � ️ Aug 13, 3 PM – 11 PM ET
F Sexy Smile Contest – � ️ Aug 18, 11 AM – Aug 28, 8 PM ET

September:

� Bling Bling Contest – � ️ Sept 3, 3 PM – 11 PM ET
� Fall for Me Contest – � ️ Sept 8, 11 AM – Sept 18, 8 PM ET
✈️ Wanderlust Contest – � ️ Sept 24, 3 PM – 11 PM ET

October:

� Golden Hour Contest – � ️ Oct 1, 3 PM – 11 PM ET



� After Dark Contest – � ️ Oct 8, 3 PM – 11 PM ET
� Goal Getter Contest – � ️ Oct 15, 3 PM – 11 PM ET
� Trick or Treat Contest – � ️ Oct 20, 11 AM – Oct 31, 8 PM ET

November:

� Talent Show Contest – � ️ Nov 5, 3 PM – 11 PM ET
� Rock Your Red Contest – � ️ Nov 12, 3 PM – 11 PM ET
� ️ Black Friday Contest – � ️ Nov 17, 11 AM – Nov 30, 8 PM ET

December:

� Cosplay Cutie Contest – � ️ Dec 3, 3 PM – 11 PM ET
☃️ Winter Wonderland Contest – � ️ Dec 10, 3 PM – 11 PM ET
� Holiday Hottie Contest – � ️ Dec 15, 11 AM – Dec 26, 8 PM ET
� Glitter Glamour Contest – � ️ Dec 31, 3 PM – 11 PM ET

Get ready to showcase your creativity, boost your engagement, and make 2025 your most successful year yet!

*Remember, contests and promotions are in Eastern Time (ET), so make sure to plan accordingly! *

LIVE Token Rush
The LIVE Token Rush is a 4-day event where Creators have the opportunity to collect millions of Tokens
circulating the platform and have the chance to become a Tokenillionaire!

How to participate:
To be eligible to win, Creators must:

Have at least 2 live shows scheduled in April and unlocked the FREE Tokens Reward Program
Go live anytime during the event

What are the prizes?
The top 3 Creators who earn the most Tokens during the entire event will win a cash prize, a ManyVids crown,
and of course, walk away with a tidal wave of Tokens!

1st place: $500
2nd place: $250
3rd place: $150

Winners will be determined based on the total number of Tokens earned during the entire event period.

How to get the most out of the promotion as a Creator:
Promote: Let your audience know about the live event. This can be done through social media, Broadcast, or via
direct messaging. Let your followers know when you are going live and to join your scheduled shows during the
event.



Engage with your audience: Before and during the live fest, engage with your audience, interact with them, and
encourage them to spend their Token balance on you.

Stream more, earn more: Every Token you collect while you’re live adds to your cumulative total, so the more
you stream, the better your chances of winning are.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Vid Bundle Bonus
Get more for less with Vid Bundles—score tons of content from your favorite Creator at one great price!

The Vid Bundle Bonus is a special, limited-time promotion. During the promotional period, Members can buy
one Vid Bundle (formerly known as Vid Membership) and they will unlock 10% off their second Vid Bundle
purchase—on us!

And the best part? That 10% off lasts for life. Your Vid Bundle will keep renewing at the discounted rate!

How it works:
Purchase your first Vid Bundle at regular price during the promotional period to qualify.
Then, you can purchase your second Vid Bundle within the same time period to receive an additional 10% discount,

courtesy of ManyVids!
The 10% discount on your second Vid Bundle will be applied automatically at checkout.
Bonus: the 10% discount will also apply to future rebills on the discounted Vid Bundle, so you can benefit for as long as

you wish!
The discount is only valid on purchases made with Credit Card or MV Wallet. Payments made with Crypto or TrustPay

are not eligible.

How to get the most out of the promotion as a Creator:
Bundle: Make sure you have a Vid Bundle available on your Profile. This is the first step to participating in the
promo and increasing your chances of earning more!

Promote: Let your followers know this deal is live! Use social media, send a Broadcast, or connect via DMs to let
them know this is the perfect time to buy more and save.

Engage: Be present and active before and during the promo period! Post teasers, answer messages, and
highlight your Bundles. A little extra engagement can go a long way in driving sales.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*

Marketplace Champ
The MarketPlace Lander is officially here, and to celebrate its launch, we are excited to announce a new promo:
The MarketPlace Champ! This new landing page and promotion are designed to shine a spotlight on all of the
amazing physical Store Items on ManyVids! For more details on the MarketPlace Lander, click here.

During the promotional period, Creators are encouraged to upload, promote and sell as many physical Store
Items as they can. At the end of the promo, the Top 3 Creators who earned the most in physical Store Item



sales during the promotional period will win sweet prizes which include incredible platform visibility, increased
payouts, and special recognition—and Members can score big too!

Prize Breakdown:
1st Place Creator (The MarketPlace Champ) will receive:

A 95% payout on all physical Store Item sales made during the promo
An Official ManyVids Crown
A 7-day feature on the Ad Spot and MarketPlace Lander
A promotion on the official ManyVids social media
One of their Store Items featured in a MarketPlace Homepage Banner vid

2nd Place Creator will receive:

A 85% payout on all physical Store Item sales made during the promo
A 5-day feature on the Ad Spot and MarketPlace Lander
A promotion on the official ManyVids social media
One of their Store Items featured in a MarketPlace Homepage Banner vid

3rd Place Creator will receive:

A 3-day feature on the Ad Spot and MarketPlace Lander
A promotion on the official ManyVids social media
One of their Store Items featured in a MarketPlace Homepage Banner vid

And, Members can win too! The Top 3 Members who spend the most on physical Store Items during the promo
period will each receive a FREE 12-month Premium Membership, which includes the FREE Tokens that can be
used across the LIVE platform!

Important Information:
This promotion includes physical Store Items (digital Items do not qualify)
Winners are determined by total revenue of physical Store Items during the promo period
Any payout increases will be awarded as bonuses once the promo ends and winners are announced

How to Get the Most Out of the Promotion as a Creator:
Promote Your Items: Spread the word via social media, Broadcasts, and DMs. Highlight new, exclusive, or
limited-edition items to generate excitement.

Engage With Your Audience: Connection drives sales! Whether you’re offering custom merch or one-of-a-kind
memorabilia, stay active and interact with your followers to boost results.

*Remember, promos are in Eastern Time (ET), so make sure to plan accordingly!*


